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ABSTRACT 

All computer operating systems in use today support serial ports, because serial ports have

n around for decades. Parallel ports are a more recent invention and are much faster than

serialports. USB ports are only a few years old, and will likely replace both serial and

allel ports completely over the next several years.

The name "serial" comes from the fact that a serial port "serializes" data. That is, it takes a

yte of data and transmits the 8 bits in the byte one at a time. The advantage is that a serial

rt needs only one wire to transmit the 8 bits (while a parallel port needs 8). The

· advantage is that it takes 8 times longer to transmit the data than it would if there were 8

ires. Serial ports lower cable costs and make cables smaller.

Before each byte of data, a serial port sends a start bit, which is a single bit with a value of O. ,,•.
···""=
iı,

Aftereach byte of data, it sends a stop bit to signal that the byte is complete. It may also send

parity bit.

The synthesizer that generates the design taking the consideration of the Xilinx

FPGA device that we specified at the top level design. Each programmable chips have own

haracteristic. The same VHDL code is portable and can be synthesized to different

FPGA programmable devices. We used Xilinx development system and Xilinx

rogrammable devices because each vendor's tools are developed its on programmable

vıces.
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HDL

VHSIC

ASIC

RAM

RTL

FPGAQ

CLB

PLD

IEEE

IC

Ada

UART

List of Abbreviations.

Hardware description Language

Very High Speed Integrated Circuit

Application Specific Integrated Circuits

Random Access Memory

Register transfer level

Field Programmable Gate Arrays

configurable logic blocks

Programmable Logic Devices

The Institute of Electrical and Electronics Engineers (read eye­

triple-e)

Integrated circuits

Name of Programming Language

Universal Asynchronous Receiver/Transmitter
••
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INTRODUCTION 

The aim of this project is to design UART Transmitter. The project consists of two chapters

.ith introduction in the beginning and conclusion at the end.

Chapter one presents is the design description of UART Transmitter and describing its

ain functions including ground realities in VHDL with its basic concepts.

Chapter two is about the Tool description of the Project in which detailed explanations

bout the Xilinx-iSE as well as description of the usage of project Navigator in VHDL and

basic concepts, function, design, syntaxes, language codes and different rule of statements

·lıich I used in my project.

Finally, the conclusion section presents the important results obtained within the project,

ferences used in the whole task.

•.
•
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CHAPTER 1

UART Transmitter

DESIGN.
1. Defining the Function.

1.1 What it does:
UART stands for Universal Asynchronous Receiver and Transmitter. It is a protocol

used in many places often including connecting terminals to computers. We'll look at the
transmitter part of a UART.

1. 1. 1 Specifications:
Data will be sent bit serially (one bit at a time) through a single line. The bit rate will

be xx KHz. That means xxOO bits will arrive each second. (This is actually the rate for a MIDI
UART communication. Computers generally run at 115.2 KHz). In each UART byte, there
will be a start bit, the 8-bits of actually data, and a stop bit. This is shown below:

Start Parity Bit Bit Bit Bit Bit Bit Bit Bit Stop
2Bit Bit O 1 2 3 4 5 6 7 Bit

We do have parity bit present in here beside start bit.
Therefore totally number of bit we have at the end is 12.

Total No of Bit to send= 12bits

The transmitter's job is to get 8-bits of data (in parallel) and send each bit one at a time~
(Datafnıt) when it sees a Start signal. When our transmitter finishes transmitting, it tells us
using a single bit output, Data_Sent. Here's the transmitter's block's 1/0:

8
"7 UART .._

Transmitter ,
) .._

,K
,

)[> •

Da
Sta Data_Sent

Data Out
CL •

The clock we will use in our circuit is a 16MHz clock.

Now let's build the STD for the transmitter. Here's some pseudo-code for our STD:

1) Wait for Start signal
2) Grab data (and adding a START bit and END bit for a total of 10-bits.)
3) For 10 bits:

a. Put data bit to be sent on output (Dataüut)
b. Keep sending it until time to send next piece of data

5



c. Go to a.
4) Go to 1.

Here we see that there are states that wait time, and a state that counts how
many times we've passed through it. Few other complexities are control word and
parity check.

1. 1 .2 Parity bit.

A parity bit is a binary digit that is added to ensure that the number of bits with value of one
in a given set of bits is always even or odd. Parity bits are used as the simplest error detecting
code.
There are two variants of parity bits: even parity bit and odd parity bit. An even parity bit is
et to 1 if the number of ones in a given set of bits is odd (making the total number of ones,

including the parity bit, even). An odd parity bit is set to 1 if the number of ones in a given set
of bits is even (making the total number of ones, including the parity bit, odd).

1.1.3 Control word.

A control word figures out the number of bits to be send if they are less than 8 bit or not , that
is just to recognize the number of bits to be send.

1.1.4 Synchronous Serial Transmission.

Synchronous serial transmission requires that the sender and receiver share a clock with one
another, or that the sender provide a strobe or other timing signal so that the receiver knows
when to "read" the next bit of the data. In most forms of serial Synchronous communication,
if there is no data available at a given instant to transmit, a fill character must be sent instead
o that data is always being transmitted. Synchronous communication is usually more

efficient because only data bits are transmitted between sender and receiver, and synchronous
ommunication can be more costly if extra wiring and circuits are required to share a clock
ignal between the sender and receiver.

1.1.5 Asynchronous Serial Transmission.
~

Asynchronous transmission allows data to be transmitted without the sender having to send a
lock signal to the receiver. Instead, the sender and receiver must agree on tirping parameters

in advance and special bits are added to each word which "are used to synchronize the sending
and receiving units.

When a word is given to the UART for Asynchronous transmissions, a bit called the "Start
Bit" is added to the beginning of each word that is to be transmitted. The Start Bit is used to
alert the receiver that a word of data is about to be sent, and to force the clock in the receiver
into synchronization with the clock in the transmitter.

6



1. 1 .6 Inputs & Outputs

In my project here I use the following design,

CTRLWORD= Controls the number of bits

TBR= Parallel Data

CRL= Load the control word

~R= Master Rest

SFD= Controls the Output by TBRE

TBRL= Parallel Data Load

TRC= Transmit Clock

TBRE= Output controlled by SFD input

TRE= Transmit Error

TRO= Transmit Output

used a pakage in the design.

1.1.7 Package.

_-\ package is the physical packaging of a chip, for example, PG84, VQlOO, and PC48.
,lıere we define the functions. In the project of I have been defining the fuction of parity
.hich is a standard logic vector input earring 0-7 bits totally 8 and returns the output.

Package is simply nothing but a fuctiou of parity.

Code. ..
•

ckage my_package is

FUNCTION parity(inputs: std_logic_vector(7 downto O)) RETURN std_logic;

end my_package;

7



1.1.8 Package Body.

The complete task for a package to be done in that particular package.

Code.
PACKAGE body my_package is

FUNCTION parity(inputs: std_logic_vector(7 downto O)) RETURN std_logic is
variable temp: std_logic;
begin

temp:='0';
for i in 7 downto O loop

temp:=temp xor inputs(i);
end loop;

return temp;
end parity;

end my_package;

Baud Rate.

Baud Rate represents the number of bits that are actually being sent over the media.

Data rate. 

The amount of data that is actually moves from one medium to medium.

Modern high speed modems (2400, 9600, 14,400, and 19,200bps)

106/19200bps* = 52.083µsec

For each bit of data required to be sent= 16 clocks

So in 52.083µsec I have 16 clocks
••

Therefore, •

52.083/16= 3.255125 µsec
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• Clock High Time: 1.6276 µsec.
• Clock Low Time: 1.6276 µsec.
• Input Setup Time: O µsec.
• Output V

,4, Delay or Wait time: 10 µsec.
• Offset: O µsec
• Global Signals: GSR (FPGA)

Total clock Time= 3.255125µsec

To calculate the clockfrequency,

=111'
=113.256* 1o"
= 103103/3.256

f=307.125kHz 

3.255125µsec = 307.125kHz 

••

9
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Synthesis

VHDL DESIGN FLOW 

VHDL entrv•'
(RTL level '•ı.•.. - ·. -.·,. ,, ... , . -,..

Compilatiorı

Netli st
(Gate level)

Opti mization

,.)> ,t··ı· ·1n·1· .,,,, ;I ·1·1:r··t·J '.·, t·•\._. I:· ... l .. ,,e( ' ....V,· .. ıs
(Gate level) Simulation

Place & Route

Physical
device Sirnul ation,- . '. '. --·- .....

Figure 1. l 
Summary of VHDL design flow.

..
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UART DESIGN FLOW

Creating UART
Transmitter Project

Create the HDL
source of the project

Sythesize

Create a test bench

Input some random
BITS

Sinmulate the Design

Implementation

Generate the
Programming File

PROGRAM THE
DEVICE
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PROCEDURE STEPS
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WRITING the VHDL code & Entering the DESIGN.

I use the xilinx - ISE integrated software environment to create the UART Transmitter
Project and enter the VHDL code.
1.2. 1 Create a New Project.
Create a new iSE project which will target the FPGA device on the SPARTAN-3E

New Project 

Save Project As: ...

-] New

~ Open .•.
Oose

-- cceace uace :
€- -- 1)e.;::~:;;,'B şıesıe :

t.c.dul~ aeree:

'<€~ S,rw, CW·S
Seve As.•.

fl '..<w~:Afl

-- P:ı::oj~c,;. şıerse :
-- 7a.r'ge::. pev.ıoee :

11 ue ecr ıpc ı.cn:
1.2
.13 ·· ·· D~ıce:n,kl"lt::ii!·:::'Print.Previeıı,:".

) Print.•.

Recent Files

Ctf!+P

H -- ?:s::"'1:i.zi,:,n O .Dl -· fil~ ceeeeee
17 --··· f'.ddicrces ı. coresence :
16.
19 -------------- - - ---- - - ---------- ----- -- - - - - -------------- - - - - - - -----·--------- - - .. - - -Exit
20

22
23
21 ------- - - ------ -- - -- - -----·---- ------ -- - - - - ---------------- - - - - -- ------------
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Enter a Name and LocaUonı for the Prcgeci
Project Name: Project Locafıon

art_Transmitter 'C:\Xilirıx:9li\Myprı:::tjects\uart_Trcınsmitte~
--""'""""""'__________ ---------- -----'"---

Select the Type-af Top-Level Source forthe Projeci
Ta,p-tevel Source Type:

nen the table is complete, your project properties will look like the following:
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Select Source Type. 

~BMMFıle
·, IP (Coregen & .A.rchitecture V1ı'izard)

I MEMFile
Schematic
lmplernerıtation Constraints File
State Diagram

I T..est Be-r. ıch \.Na. vefomıUser Document
Venlog Module
Veı:ilc,g Test Fıxture·
VHDL Module

. VHDLUbraıy
PJ VHDL Package
J VHDL Test Bench

Fileınarne:

'lTIER

:\Users\woper\Desktop\My Project\uaıt.Jransmitt-el
=~="~"'~~,·~~--"-·· ·' .~'"~-"""-~'>'" . --.-----~,J

A.dd to project

Defining the Module. 'I:

15



ART Transmitter Project in iSE. 

U5Z. ieee . -5t-d).:::ı;r::.-::.JJ.6S,.?ı.LL;
USE ı eee c s •.;-ı_ı"ıt~_urı:::iç:,>ed.a·,~·
LTSE .ıeee.nceerıc .::t.d.ALL;

ENTEY uart trar.emitt-::::: tb vtıd IS
END uert _trar,:ımitter_tb _vtd;

ARCHIT·ECTJR.E behevacr OF uar't _ereneeı t.ter _tb _vhd IS

-- ;..ç,:r;p,.::,nent !}:::ı::la:r.a,.;;,.ren tcx. ı;t,e Dnit Unfier reac !,UUTJ
CO?PCNENT trans

43

PORI l
TRC ; IN std_lqi:;
HR : IN ,\H'.t.\ . .: q·.t(.::

44 'IE!.RL : IN :=:,;.:ct.._.':.cır;:L::;
45 SFD : IN et.d_].C'.qic;
46 GRL IN

CTRLWORD
43 T3R : IN .,td_loqic_vector !1 dcentc 0);
49 TRE : our 3tct l:J';ic;
50 'I3RE : OUT :=Jt1__ _.':.Dtic;
51 TRC : CUT nd .t:,-gic-
52 I;
5.3 EHD CC+!PONEN1;
51
55
56

--.I'ı:rpuı:.::
5IGfüU. TRC std_lo.gic 'ü';

57 SIGNAL HR : :n:1 __ _.'LOf:.i/; := '11;

5$ 5IGNA.:-TBR1 ::ıı;-ct ı.o,;ric := '01;

•
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.2 VHDL CODE OF UART TRANSMITTER.

-Company:
- Engineer:

Near East University
Nadeem Hassan

- Create Date:
- Design Name:
- Module Name:
- Project Name:
- Target Devices:
- Tool versions:
- Description:

09: 16:59 02/19/2008

uart_transmitter - Behavioral

- Dependencies:

- Revision:
- Revision O.O 1 - File Created
- Additional Comments:

- UART Transmitter Model (behavior modeling)

ibrary ieee;
-e ieee.std_logic_l 164.all;

ckage my_package is

FUNCTION parity(inputs: std_logic_ vector(7 downto O)) RETURN std_logic;

end my_package;

PACKAGE body my_package is

FUNCTION parity(inputs: std_logic_ vector(7 downto O)) RETURN std_logic is
variable temp: std_logic; •
begin

temp:='0';
for i in 7 downto O loop

temp.etemp xor inputs(i);
end loop;

return temp;
end parity;

end my_package;

17
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rary ıeee;
-- ieee.std_logic_l 164.all;
~- ieee.std_logic_arith.all;
-- ieee.std_logic_unsigned.all;

work.my _package. all;

tity trans is
rt( TRC: in std_logic;

MR: in std_logic;
TBRL: in std_logic;
SFD: in std_logic;
CRL: in std_logic;
CTRLWORD:in std_logic_vector(4 downto O);
TBR: in std_logic_ vector(7 downto O);
TRE: out std_logic;
TBRE: out std_logic;
TRO: out std_logic

d trans;

bitecture behv of trans is

onstant CO: unsigned(4 downto 0):="00001 ";
onstant CI: unsigned(4 downto 0):="01000";
onstant CM: unsigned(4 downto 0):="10000";
onstant MM: unsigned(3 downto O):="1111 ";
ignal trans_reg: std_logic_ vector(l 1 downto O);
ignal trans_reg_temp: std_logic_ vector(l 1 downto O);
ignal TBR_sig: std_logic_ vector(7 downto O);
ignal old_tbr_sig: std_logic_ vector(7 downto O);
ignal delay: std_logic_ vector(O down to O);
ignal go: std_logic;
.ignal t_pari: std_logic;

signal elk: std_logic;
ignal i: unsigned(3 downto O);
ignal ctrl_word: std_logic_vector(4 downto O);

: process(MR,TRC,i,TBR) -- generate 16.* clock

i<="OOOOO";
elsif TRC='l' and TRC'event then

i<=i+CO;
if i=Cl then

clk<='l';
elsif i=CM then

i<="OOOOO";
clk<='O';

end if;

18
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end if;

ocess(CRL,CTRL WORD) -- load control word here

if CRL=' 1' then
ctrl_ word<=CTRLWORD;

end if;

process make out the transmit register according to control word.
ocess( clk,ctrl_ word,MR, TBR, TBRL, TBR_sig, t_pari)

if (MR=' 1 ') then
TBR_sig<=11l 111111111;

t_pari <= 'O';
trans_reg_temp <= 11111111 & TBR_sig;

else
if TBRL='O' then

TBR_sig <= TBR;
t_pari <= parity(TBR); -- call function and compute the parity

end if;

case ctrl_ word is
when 110000011l110000111 =>

if t_pari='O' then -- odd parity
trans_reg_temp <= 1111111 & 111111 & '1' & TBR_sig(4 downto O) & 'O';

elsif t_pari=' 1' then -- even parity
trans_reg_temp <= 1111111 & 111111 & 'O' & TBR_sig( 4 downto O) & 'O';

end if;
when 11000l011l11000l 111 =>

if t_pari='O' then -- odd parity
trans_reg_temp <= 1111111 & 111111 & 'O' & TBR_sig( 4 down to O) & 'O';

elsif t_pari=' 1' then -- even parity
trans_reg_temp <= 111 lJ11 & 111111 & '1' & TBR_sig(4 downto O) & 'O';

end if;
when 1100l0011l1100l l011l1100101111110011111 => -- no parity

trans_reg_temp <= 11111111 & 111111 & TBR_sjg( 4 downto O) & 'Q!; 
when 110l00011l110lOOl 11 =>

if t_pari='O' then -- odd parity
trans_reg_temp <= 111111 & 111111 & '1' & TBR_sig(5 downto O) & 'O';

elsif t_pari=' 1' then -- even parity
trans_reg_temp <= 111111 & 111111 & 'O' & TBR_sig(5 downto O) & 'O';

end if;
when 110l01011l110l0l 111 =>

if t_pari='O' then -- odd parity
trans_reg_temp <= 111111 & 111111 & 'O' & TBR_sig(5 downto O) & 'O';

19



elsif t_pari=' 1' then -- even parity
trans_reg_temp <= "11" & "11" & '1' & TBR_sig(5 downto O) & 'O';

end if;
when "Ol 100"1"011l011l110l 101111110111111 => -- no parity

trans_reg_temp <= 11111" & 111111 & TBR_sig(5 downto O) & 'O';
when "l000011l111000l" =>

if t_pari='O' then -- odd parity
trans_reg_temp <= 'l' & 1111" & '1' & TBR_sig(6 downto O) & 'O';

elsif t_pari=' 1' then -- even parity
trans_reg_temp <= '1' & 111111 & 'O' & TBR_sig(6 downto O) & 'O';

end if;
when 1110010"1"1001111 =>

if t_pari='O' then -- odd parity
trans_reg_temp <= '1' & 111111 & 'O' & TBR_sig(6 downto O) & 'O';

elsif t_pari=' 1' then -- even parity
trans_reg_temp <= '1' & 111111 & '1' & TBR_sig(6 downto O) & 'O';

end if;
when 111010011111101101111110101111111011111 => -- no parity

trans_reg_temp <= "1111 & 111111 & TBR_sig(6 downto O) & 'O';
when 1111000111"1100111 =>

if t_pari='O' then -- odd parity
trans_reg_temp <= 111111 & '1' & TBR_sig(7 downto O) & 'O';

elsif t_pari=' 1' then -- even parity
trans_reg_temp <= 111111 & 'O' & TBR_sig(7 downto O) & 'O';

end if;
when 1111010"1"1101111 =>

if t_pari='O' then -- odd parity
trans_reg_temp <= 111111 & 'O' & TBR_sig(7 downto O) & 'O';

elsif t_pari=' 1' then -- even parity
trans_reg_temp <= 111111 & '1' & TBR_sig(7 downto O) & 'O';

end if;
when others => -- no parity

trans_reg_temp <= '1' & 1111" & TBR_sig(7 down to O) & 'O';
end case;

end if;
end process;

..
- P3 describes the whole transmission procedure
P3: process

variable cnt: integer range O to 12;
variable cnt_limit: integer range O to 12;

begin

••

wait until TRC'event and TRC=' 1 ';

if MR=' 1' then
old_tbr_sig <= 11 1 1 1 1 1 1 1 111;

delay-c='D";
go<='O';

20



i <= "0000";
else

if (i=MM) then
i<="OOOO";
if(go='O') then

delay<="O";
cnt := 12;
TRE <= '1';
if (old_tbr_sig=TBR_sig) then

go<= 'O';
elsif (old_tbr_sig/=TBR_sig) then

go <='1';
end if;
trans_reg <= "111111111111 ";

elsif (go='l' and delay="O") then
go<='l';
cnt:=0;
delay-c=delay+ 1;
TRE <= '1';
trans_reg <= "111111111111 ";

elsif (go=' 1' and delay=" 1" and cnt=ü) then
go<= '1';
cnt:=cnt+ 1;
delay-c=delay+Ü;
old_tbr_sig<=TBR_sig;
TRE<='O';
trans_reg <= trans_reg_temp;

elsif (go=' 1' and delay>" 1" and cnt/=0) then
trans_reg <= '1' & trans_reg(l 1 downto 1);
case ctrl_word(4 downto 2) is

when "000" => if ctrl_ word(O)='O' then
cnt_limit := 8;

elsif ctrl_ word(O)=' 1' then
cnt_limit :=9;

end if;
when "001" => if ctrl_word(O)='O' then

cnt_limit := 7;
elsif ctrl_ word(O)=' 1' then

cnt_limit :=8;
end if;

when "010" => if ctrl_word(O)='O' then
cnt_limit := 9;

elsif ctrl_ word(O)=' 1' then
cnt_limit :=10;

end if;
when "011" => if ctrl_word(O)='O' then

cnt_limit := 8;
elsif ctrl_ word(O)=' 1' then

cnt_limit :=9;
end if;

when "100" => if ctrl_ word(O)='O' then

•
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cnt_limit := 10;
elsifctrl_ word(O)=' 1' then

cnt_limit :=11;
end if;

when 1110111 => if ctrl_word(O)='O' then
cnt_lirnit := 9;

elsif ctrl_ word(O)=' 1' then
cnt_limit := 1 O;

end if;
when 1111011 => if ctrl_word(O)='O' then

cnt_limit :=11;
elsif ctrl_ word(O)=' 1' then

cnt_lirnit :=12;
end if;

when 11 11111 => if ctrl_ word(O)='O' then
cnt_limit := 1 O;

elsif ctrl_ word(O)=' 1' then
cnt_limit : = 11;

end if;
when others=>

end case;

if crıt/ecntIimit then
go<= '1';
delay<=delay+O;
cnt:=cnt+ 1;
TRE<='O';

elsif cnt=cnt_limit then
go<= 'O';
delay-c='f)";
TRE<='l';

end if;
end if;

if SFD='l' then
TBRE<= 'Z';

elsif SFD='O' then
if (cnt=Ü or cnt= 1) then

TBRE<= 'O';
else

TBRE <= '1';
end if;

end if;
else

i<=i+ 1;
end if;

end if;
end process;

..
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-- this cocurrent statement handles the serial output of Transmitter
tro <= trans_reg(O);

end behv;

<< >>

1.3 SYNTHESIS

I use the Xilinx-iSE- 'synthesis tool' to synthesize the code.

The synthesis Report goes as follows
• Synthesis Options Summary
• HDL Compilation
• Design Hierarchy Analysis
• HDL Analysis
• HDL Synthesis
• Advanced HDL Synthesis
• Low Level Synthesis
• Partition Report
• Final Report

The synthesize result is shown below:

Release 9.1.02i - xst J.32
Copyright (c) 1995-2007 Xilinx, Inc. All rights reserved.
--> Parameter TMPDIR set to .zxst/prcjnav.tınp
CPU: 0.00 I 1.73 s I Elapsed: 0.00 I 2.00 s ..
--> Parameter xsthdpdir set to ./xst
CPU : 0.00 I 1 .73 s I Elapsed : 0.00 I 2.00 s

--> Reading design: trans.prj

TABLE OF CONTENTS
1) Synthesis Options Summary
2) HDL Compilation
3) Design Hierarchy Analysis
4) HDL Analysis
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5) HDL Synthesis
5.1) HDL Synthesis Report

6) Advanced HDL Synthesis
6. 1) Advanced HDL Synthesis Report

7) Low Level Synthesis
8) Partition Report
9) Final Report

9. 1) Device utilization summary
9.2) Partition Resource Summary
9.3) TIMING REPORT

----------~-------------------------------------------------------- 
=====
* Synthesis Options Summary *
------------------------------------------------------------------- 
======
---- Source Parameters
Input File Name : "trans.prj"
Input Format : mixed
Ignore Synthesis Constraint File : NO

---- Target Parameters
Output File Name
Output Format
Target Device

"trans"
:NGC

: xc3s500e-5-fg320

---- Source Options
Top Module Name
Automatic FSM Extraction
FSM Encoding Algorithm
Safe Implementation
FSM Style : Jut
RAM Extraction : Yes
RAM Style : Auto
ROM Extraction : Yes
Mux Style : Auto
Decoder Extraction : YES
Priority Encoder Extraction : YES
Shift Register Extraction : YES
Logical Shifter Extraction : YES
XOR Collapsing : YES
ROM Style : Auto
Mux Extraction : YES
Resource Sharing : YES
Asynchronous To Synchronous : NO
Multiplier Style : auto
Automatic Register Balancing

: trans
: YES
: Auto

:No

•.
•

:No

---- Target Options
Add IO Buffers : YES
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Global Maximum Fanout : 500
Add Generic Clock Buffer(BUFG) : 24
Register Duplication : YES
Slice Packing : YES
Optimize Instantiated Primitives : NO
Use Clock Enable : Yes
Use Synchronous Set : Yes
Use Synchronous Reset : Yes
Pack IO Registers into IOBs : auto
Equivalent register Removal : YES

--- General Options
Optimization Goal
Optimization Effort
Library Search Order
Keep Hierarchy
RTL Output
Global Optimization
Read Cores
Write Timing Constraints
Cross Clock Analysis
Hierarchy Separator
Bus Delimiter
Case Specifier
Slice Utilization Ratio
BRAM Utilization Ratio
Verilog 2001
Auto BRAM Packing
Slice Utilization Ratio Delta

: Speed
: 1

: trans.lso
:NO

: Yes
: AllClockNets

: YES
:NO

:NO
:/

: <>
: maintain

: 100
: 100

: YES
:NO

:5

=====
-- ---------------------------------------------------- 

-- ---------------------------------------------------- 
=====

HDL Compilation *
--- --------------------------------------------------- 
=====
Compiling vhdl file "C:/Xilinx9 li/xilinx/myprojects/uart_transmitter/uart_transmitter. vhd" in
Library work.
Package <my_package> compiled.
Package body <my_package> compiled.
Entity <trans> compiled.
Entity <trans> (Architecture <behv») compiled.

•

-- -------------------------------------------------- 
====== 
* Design Hierarchy Analysis *
--- --------------------------------------------------- 
====== 
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yzing hierarchy for entity <trans> in library <work> (architecture <behv> ).

~
--------------------------------- 

--------------------------------------------------- 
HDL Analysis *

yzing Entity <trans> in library <work> (Architecture <behv» ).
ity <trans> analyzed. Unit <trans> generated.

HDL Synthesis *
- ----------------========================================== 

arming bidirectional port resolution ...

• thesizing Unit <trans>.
Related source file is
:ıXilinx91 i/xilinx/myprojects/uart_transmitter/uart_transmitter. vhd 11•

ARNING:Xst: 1780 - Signal <elk> is never used or assigned.
ARNING:Xst:737 - Found 8-bit latch for signal <TBR_sig>.
·.-\RNING:Xst:737 - Found I-bit latch for signal <t_pari>.
·.-\RNING:Xst:737 - Found 5-bit latch for signal <ctrl_ word>.
·..\RNING:Xst - Property 11use_dsp48 11 is not applicable for this technology.
Found I-bit register for signal <TRE>.
Found I-bit tristate buffer for signal <TBRE>.
Found 4-bit register for signal <cnt».
Found 4-bit adder for signal <cnt$add0000> created at line 272.
Found 4-bit comparator equal for signal <cnt$cmp_eq0001> created at line 269.
Found 4-bit comparator not equal for signal <cnt$cmp_ne0000> created at line 269.
Found 4-bit 8-to-1 multiplexer for signal <cnt_limit$mux0001> created at line 225.
Found I-bit register for signal <delay-cüx».
Found I-bit register for signal <go>.
Found 8-bit comparator equal for signal <go$cmp_eq0001> created at line 204.
Found 4-bit up counter for signal <i>, @I

Found I-bit register for signal <Mtridata , TBRE> created at line 282.
Found I-bit register for signal <Mtrien , TBRE> created at line 282.
Found 8-bit register for signal <old_tbr_sig>. •
Found I-bit xor8 for signal <t_pari$xor0001> created at line 41.
Found 12-bit register for signal <trans_reg>.
Summary:

inferred

••

inferred
inferred
inferred
inferred
inferred

1 Counter(s).
29 D-type flip-flop(s).

1 Adder/Subtractor(s).
3 Comparator(s).
4 Multiplexer(s).
1 Xor(s).
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inferred 1 Tristate(s).
Unit <trans> synthesized.

------------
HDL Synthesis Report

Macro Statistics
# Adders/Subtractors
4-bit adder
# Counters
4-bit up counter
# Registers
1-bit register
12-bit register
4-bit register
8-bit register

# Latches
1-bit latch
5-bit latch
8-bit latch

# Comparators
4-bit comparator equal
4-bit comparator not equal
8-bit comparator equal

# Multiplexers
4-bit 8-to- l multiplexer
# Tristates
1-bit tristate buffer

#Xors
1-bit xor8

------------

------------

: 1
: 1

: 1
: 1

:8
:5

: 1
: 1
: 1
:3

: 1
: 1
: 1

:3
: 1

: 1
: 1

: 1
: 1

: 1
: 1

: 1
: 1

* Advanced HDL Synthesis *
------------------------------------------------------------------- • ------------

Loading device for application Rf_Device from file '3s500e.nph' in environment C:\Xilinx91i.

------------
Advanced HDL Synthesis Report

Macro Statistics
# Adders/Subtractors
4-bit adder

: 1
: 1

27



# Counters
4-bit up counter
# Registers
Flip-Flops
# Latches
l-bit latch
5-bit latch
8-bit latch

# Comparators
4-bit comparator equal
4-bit comparator not equal
8-bit comparator equal

# Multiplexers
4-bit 8-to-1 multiplexer
#Xors
l-bit xor8

: 1
: 1

: 29
: 29
:3

: 1
: 1
: 1

:3
: 1

: 1
: 1

: 1
: 1

: 1
: 1

------------

====== 
* Low Level Synthesis *
======

Optimizing unit <trans> ...
WARNING:Xst: 1710 - FF/Latch <trans_reg_l 1> (without init value) has a constant value of
1 in block <trans>.
WARNING:Xst: 1710 - FF/Latch <trans_reg_lO> (without init value) has a constant value of
1 in block <trans>.
WARNING:Xst: 1710 - FF/Latch <trans_reg_lO> (without init value) has a constant value of
1 in block <trans>.
WARNING:Xst: 1710 - FF/Latch <trans_reg_lO> (without init value) has a constant value of
1 in block <trans>.
WARNING:Xst: 1710 - FF/Latch <trans_reg_lO> (without init value) has a constant value of
1 in block <trans>.

Mapping all equations ...
Building and optimizing final netli st ...
Found area constraint ratio of 100 (+ 5) on block trans, actual ratio is 1. •

Final Macro Processing ...

======
Final Register Report

Macro Statistics
# Registers
Flip-Flops

: 31
: 31
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------------

------------
------------------------------------------------------------------- 

* Partition Report *
------------

Partition Implementation Status

No Partitions were found in this design.

------------
*
------------

Final Report *

Final Results
RTL Top Level Output File Name : trans.ngr
Top Level Output File Name : trans
Output Format : NGC
Optimization Goal : Speed
Keep Hierarchy : NO

Design Statistics
#IOs :21

: 96
: 1
:8

: 1
: 15

: 1
: 51

:5
:8
:6

: 45

•

Cell Usage:
#BELS
# INV
# LUT2
# LUT2_D
# LUT3
# LUT3_D
# 'LUT4
# LUT4_D
# LUT4_L
# MUXF5
# FlipFlops/Latches
# FDE
# FDR
# FDRE
# FDSE

: 13
:4
:6
:8
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LD
LDC_l
LDP_l

:5

O Buffers
IBUF
OBUF
OBUFT

: 1
:8

:3
:3

: 18
: 15
:2

: 1

vice utilization summary:

Iected Device : 3s500efg320-5

· mber of Slices:
· mber of Slice Flip Flops:
· mber of 4 input LUTs:
· mber of IOs:
·umberof bonded IOBs:
IOB Flip Flops:

· mber of GCLKs:

49 out of 4656 1 o/o
40 out of 9312 0%
90 out of 9312 0%

21
21 out of 232 9%

5
3 out of 24 12%

ition Resource Summary:

_;o Partitions were found in this design.

·oTE: THESE TIMING NUMBERS ARE ONLY A SYNTHESIS ESTIMATE.
FOR ACCURATE TIMING INFORMATION PLEASE REFER TO THE TRACE
roITT • 
GENERATED AFTER PLACE-and-ROUTE.

k Information:

~--------------------------------t-------------------------t--------t 
k Signal I Clock buffer(FF name) I Load I

~--------------------------------t-------------------------t--------t 
c I BUFGP I 31 I
RL I BUFGP I 9 I
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I BUFGP ıs
~--------------------------------t-------------------------t--------t 

ynchronous Control Signals Information:

~--------------------------------t-------------------------t--------t 
ontrol Signal I Buffer(FF name) I Load I

~--------------------------------t-------------------------t--------t 
I IBUF I 9 I

~--------------------------------t-------------------------t--------t 

ıming Summary:

Minimum period: 5.686ns (Maximum Frequency: 175.858MHz)
Minimum input arrival time before clock: 5.787ns
_.faxİmum output required time after clock: 4. 040ns

ximum combinational path delay: No path found

Detail:

Mes displayed in nanoseconds (ns)

g constraint: Default period analysis for Clock 'TRC'
k period: 5.686ns (frequency: 175.858MH~)
number of paths I destination ports: 480 I 57

---- -------------------------------------------------- 
5.686ns (Levels of Logic= 3)
i_l (FF)

cnt_O(FF)
rce Clock: TRC rising
tination Clock: TRC rising

Path: i_l to cnt_O •
Gate Net

Cell:in->out fanout Delay Delay Logical Name (Net Name) •
~------------------------------------- ------------ 
FDR:C->Q
LUT4:Il->0
Lı2:Il->0

LLı4:l3->0
FDRE:R

4 0.514 0.568 i_l (i_l)
5 0.612 0.607 old_tbr_sig_notOOOl11 (go_cmp_eqOOOO)
15 0.612 0.867 cnt_andOOOOll(trans_reg_notOOOl)
4 0.612 0.499 cnt_andOOOOl (cnt_andOOOO)
0.795 cnt_O

~------------------------------------- 
otal 5.686ns (3.145ns logic, 2.541ns route)

(55.3% logic, 44.7% route)
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------------------------------------------------------ 
----------
Timing constraint: Default OFFSET IN BEFORE for Clock 'TRC'
Total number of paths I destination ports: 67 I 50

~---------------------------------------------------------------------- 
Offset: 5.787ns (Levels of Logic= 5)
Source: SFD (PAD)
Destination: cnt_2 (FF)
Destination Clock: TRC rising

Data Path: SFD to cnt_2
Gate Net

Cell.in-c-out fanout Delay Delay Logical Name (Net Name)

IBUF:I->0
LUT4:I3->0
LUT4:Il->0
LUT4:I3->0
LUT4:I3->0
FDRE:D

11 1.106 0.796 SFD_IBUF (SFD_IBUF)
1 0.612
2 0.612
1 0.612
I 0.612
0.268

0.426 cnt_cmp_ne0000199_SWO_SWO (N626)
0.383 cnt_cmp_ne0000199_SWO (N606)
0.360 cnt_mux0001<1>29 (cnt_muxOOOl<l>_maplO)
0.000 cnt_mux0001<1>65 (cnt_muxOOOl<l>)

cnt_2

Total 5.787ns (3.822ns logic, 1.965ns route)
(66.0% logic, 34.0% route)

-------------------------------------------------- 
---------

iming constraint: Default OFFSET IN BEFORE for Clock 'TBRL'
Total number of paths I destination ports: 16 I 9

------------------------------------------------------------------------- 
Offset: 3.639ns (Levels of Logic= 3)

Source: TBR<3> (PAD)
Destination: t_pari (LATCH)
Destination Clock: TBRL rising

Data Path: TBR<3> to t_pari
Gate Net

Cell.in-c-out fanout Delay Delay Logical Name (Net Name)
"'

IBUF:I->0
LUT4:I0->0
LUT2:I0->0
LDC_l:D

2 1.106 0.532 TBR_3_IBUF (TBR_3_IBUF)
1 0.612 0.509 t_pari_xor000112 (t_pari_xor0001_map6)•1 0.612 0.000 t_pari_xor00012'6 (t_pari_xorOOOl)

0.268 t_pari

Total 3.639ns (2.598ns logic, 1.041ns route)
(71.4% logic, 28.6% route)

--------------------------------------------------- 
------------
Timing constraint: Default OFFSET IN BEFORE for Clock 'CRL'
Total number of paths I destination ports: 5 I. 5

------------------------------------------------------------ 
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et: l.731ns (Levels of Logic= 1)
ource: CTRLWORD<O> (PAD)

Destination: ctrl_word_O (LATCH)
Destination Clock: CRL falling

ta Path: CTRLWORD<O> to ctrl_word_O
Gate Net

Cell:in->out fanout Delay Delay Logical Name (Net Name)

IBUF:1->0
LD:D

1 1.106 0.357 CTRLWORD_O_IBUF (CTRLWORD_O_IBUF)
0.268 ctrl_word_O

Total 1.73 Ins (l.374ns logic, 0.357ns route)
(79.4% logic, 20.6% route)

g constraint: Default OFFSET OUT AFTER for Clock 'TRC'
number of paths I destination ports: 4 I 3

4.040ns (Levels of Logic= 1)
TRE (FF)

TRE (PAD)
TRC rising

Gate Net
fanout Delay Delay Logical Name (Net 'Name)

1 0.514 0.357 TRE (TRE_OBUF)
3.169 TRE_OBUF (TRE)

4.040ns (3.683ns logic, 0.357ns route)
(91.2% logic, 8.8% route)

.72 I 19.72 s I Elapsed: 18.00 I to.oo s
••

•
mory usage is 160540 kilobytes

errors : O ( O filtered)
warnings ·. lO ( O filtered')

of infos : O ( O filtered)

<< >>
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...nx synthesis tool created the following design. Top level block diagram.

Block Diagram

•
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Detailed Magnified Circuit
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1.4 Writing Test Bench. 

the test bench generated 160 MHz. I wrote in the data in to the UART Transmitter and read
back to verify data can be written and read correctly. The simulation result is shown below.

BMM F11e
IP (Coregen & Arohttecture Wizard)

i MEMFile
Schematic

. Implementation Constraints File
(~,ıc State Diagram
.n, Test Bench 1ıVaveFcımı

, §.. Üser Document
v Veıilog Module
N1 Veıilog Teşt Ftxture
·~. VHDL Module

VHDL Ubraıy

~
\lHDL Package

U "\._;':· :., , ..-, __ i'' . '
:ff t~Q~Tef.t1B~f:Jh

Addfo project

~----------------------------------------------------------------------------- 
-Company: Near East University
- Engineer: Nadeem Hassan

-Create Date: 11:07:59 03/26/2008
- Design Name: trans
- Module Name: C:/Xilinx9 li/xilinx/myprojects/uart_transmitter/uart_transmitter_tb. vhd
- Project Name: uart_transmitter
- Target Device:
- Tool versions:
- Description:

..
•

- VHDL Test Bench Created by ISE for module: trans

- Dependencies:

-Revision:
-Revision O.Ol - File Created
- Additional Comments:

= Notes:
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- This testbench has been automatically generated using types std_logic and
- std_logic_ vector for the ports of the unit under test. Xilinx recommends
- that these types always be used for the top-level I/O of a design in order
-- to guarantee that the testbench will bind correctly to the post-implementation
-- simulation model.

LIBRARY ieee;
USE ieee.std_logic_l 164.ALL;
USE ieee.std_logic_unsigned.all;
USE ieee.numeric_std.ALL;

ENTITY uart_transmitter_tb_ vhd IS
END uart_transmitter_tb_ vhd;

ARCHITECTURE behavior OF uart_transmitter_tb_ vhd IS

-- Component Declaration for the Unit Under Test (UUT)
COMPONENT trans
PORT(

TRC : IN std_logic;
MR : IN std_logic;
TBRL : IN std_logic;
SFD: IN std_logic;
CRL : IN std_logic;
CTRLWORD: IN std_logic_vector(4 downto O);
TBR : IN std_logic_ vector(7 downto O);
TRE : OUT std_logic;
TBRE : OUT std_logic;
TRO : OUT std_logic
);

END COMPONENT;

--Inputs
SIGNAL TRC: std_logic := 'O';
SIGNAL MR : std_logic := '1 ';
SIGNAL TBRL: std_logic := 'O';
SIGNAL SFD: std logic:= 'O';

- " SIGNAL CRL: std_logic := 'O';
SIGNAL CTRLWORD: std_logic_vector(4 downto O):= (others=>'O');
SIGNAL TBR: std_logic_ vector(7 downto O) := (others=>'O'); •

•
--Outputs
SIGNAL TRE : std_logic;
SIGNAL TBRE: std_logic;
SIGNAL TRO: std_logic;

GIN

-- Instantiate the Unit Under Test (UUT)
uut: trans PORT MAP(

TRC=>TRC,
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MR=>MR,
TBRL => TBRL,
SFD => SFD,
CRL=>CRL,
CTRLWORD => CTRLWORD,
TBR=>TBR,
TRE=>TRE,
TBRE => TBRE,
TRO=>TRO

);

- Please ensure that the constant PERIOD is defined prior to the
-- begin statement in the architecture. Refer to the PERIOD Constant Template
-- for more info.

TRC <= not TRC after 10 ns;

tb: PROCESS
BEGIN

-- Wait 100 ns for global reset to finish
wait for 100 ns;

MR<='O';
TBRL<='O';
CRL<='l';
CTRLWORD<="l 1010";
TBR<="10101010";
-SFD<='l';
'ait for 500 ns;

-CRL<='O';
-~R<='O';

ait for 500 ns;
TBR<="10101010";

-- Place stimulus here

wait; -- will wait forever
END PROCESS;

••
•

u);

<< >>
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1.5 Simulating. 

have created a test bench to the UART Transmitter. In this test bench I wrote in to the
'ART Transmitter and read the data for final proof reading.

transmitting AA which is 1010 1010
cording to my simulated result i have

•.
••

Start2
o

Parity
o

A
1010

A
1010

End
1
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CHAPTER2 

Xilinx-ISE- 

. iSE General Information 

1. Xilinx iSE Overview 

The Integrated Software Environment (ISE™) is the Xilinx® design software suite

allows us to take our design from design entry through Xilinx device programming. The

E Project Navigator manages and processes our design through the following steps in the

1.2. Design Entry 

Design entry is the first step in the ISE design flow. During design entry, we create

source files based on our design objectives. We can create our top-level design file using a

dware Description Language (HDL), such as VHDL, Verilog, or ABEL, or using a

hematic. We can use multiple formats for the lower-level source files in our design. If we

working with a synthesized EDIF or NGC/NGO file, we can skip design entry and

ynthesis and start with the implementation process.

1.3. Synthesis 

After design entry and optional simulation, we run synthesis. During this step, VHDL,

"erilog,or mixed language designs become netlist files that are accepted as input to the
plementation step.

1.4. Implementation 

After synthesis, we run design implementation, which converts the logical design into

hysical file format that can be downloaded to the selected target device. From Project

- vigator, we can run the implementation process in one step, or we can run each of the

plementation processes separately. Implementation processes vary depending on whether

e are targeting a Field Programmable Gate Array (FPGA) or a Complex Programmable

gic Device (CPLD).
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1.5. Verification 

We can verify the functionality of our design at several points in the design flow. We

use simulator software to verify the functionality and timing of our design or a portion of

design. The simulator interprets VHDL or Verilog code into circuit functionality and

plays logical results of the described HDL to determine correct circuit operation.

ulation allows us to create and verify complex functions in a relatively small amount of

e. We can also run in-circuit verification after programming the device.

. 6. Device Configuration 

After generating a programming file, we configure our device. During configuration,

generate configuration files and download the programming files from a host computer to

Xilinx device. Xilinx iSE Overview Architecture Support.

. 7. Architecture Support. 

iSE™ software supports the following device families.

41



rating System Support.

iSE™ software is supported on the following operating systems.

2.2. Using Project Navigator

1. Project Navigator Overview

Project Navigator organizes our design files and runs processes to move the design from

ign entry through implementation to programming the targeted Xilinx® device. Project

-igator is the high-level manager for our Xilinx FPGA and CPLD designs, which allows us

ı0 the following:

Add and create design source files, which appear in the Sources window

Modify the source files in the Workspace

Run processes on the source files in the Processes window

View output from the processes in the Transcript window
••

••
. Project Navigator Main Window

The following figure shows the Project Navigator main window, which allows to

•

ge our design starting with design entry through device configuration.
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EııorsandWarnings
ı.!:A Synthesis Messages

!2J Translation Messages
:···· [dl Map Messages
)··-~Place and Route Messages
i""· 0 Timing Messages
l .. [;lü;tg,,cUcı,o,e,

Figure 1.1 Main Window of Project Navigator

Tool bar

- Sources window

Processes window

Workspace

5 Transcript window

•
•
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2.2.3. Using the Sources Window 

The first step in implementing our design for a Xilinx® FPGA or CPLD is to assemble

the design source files into a project. The Sources tab in the Sources window shows the

ource files us create and add to our project, as shown in the following figure.

Figure 1.2 Sources Window

The Design View ("Sources for") drop-down list at the top of the Sources tab allows

view only those source files associated with the selected Design View (for instance,

esis/Implementation). The "Number of" drop-down list, Resources column, and

rve column are available for designs that use Partitions.

The Sources tab shows the hierarchy of our design. We can collapse and expand the

by clicking the plus (+) or minus (-) icons. Each source file appears next to an icon that

its file type. The file we select determines the processes available in the Processes

w. We can double-click a source file to open it for editing in the Workspace. For

ation on the different file types, you can change the project properties, such as the

family to target, the top-level module type, the synthesis tool, the simulator, and the
ted simulation language. ~

Depending on the source file and tool we are working with, additional tabs are available in
•

Always available: Sources tab, Snapshots tab, Libraries tab

Constraints Editor: Timing Constraints tab

Floorplan Editor: Translated Netlist tab, Implemented Objects tab

hematic Editor: Symbols tab

hnology Viewer: Design tab

· g Analyzer: Timing tab
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2.2.4. Using the Processes Window 

The Processes tab in the Processes window allows us to run actions or "processes" on

the source file we select in the Sources tab of the Sources window. The processes change

cording to the source file we select. The Process tab shows the available processes in a

· erarchical view. We can collapse and expand the levels by clicking the plus (+) or minus (-)

· ons. Processes are arranged in the order of a typical design flow: project creation, design

entry, constraints management, synthesis, implementation, and programming file creation.

Depending on the source file and tool we are working with, additional tabs are available in

the Processes window:

• Always available: Processes tab

• Floorplan Editor: Design Objects tab, Implemented - Selection tab

• iSE Simulator: Hierarchy Browser tab

• Schematic Editor: Options tab

• Timing Analyzer: Timing Objects tab

View Design Summary
Design Utilities

Create Schematic Symbol
~ View CommandLine Log File

'·-- ed9Check Design Rules
~ View HOL Functional Model
~ View HDL Instantiation Template

Create Timing Constraints
Assign Package Pins
CreateArea Constraints
Edit Constraints (Text)

Synthesize · XST
'--~ View Synthesis Report
i.[EJ View RTL Schematic
•. · [;2) View Technology Schematic

l±l· ea Gener~e Post-SynthesisSimulation l~odel
I mplemenl Design

Translate
Map

•.
••

Figure 1.3 Process Window
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2.2.5. Process Types 

The following types of processes are available as we work on our design:

• Tasks

When we run a task process, the iSE software runs in "batch mode," that is, the software

recesses our source file but does not open any additional software tools in the Workspace.

Output from the processes appears in the Transcript window.

• Reports ~

Most tasks include report sub-processes, which generate a summary or status report, for

instance, the Synthesis Report or Map Report. When we run a report process, the report

ppears in the Works pace.

• Tools

When we run a tools process, the related tool launches in standalone mode or appears in

e Workspace where we can view or modify our design source files. The icons for tools

ırocesses vary depending on the tool. For example, the Timing Analyzer icon is shown above .

. 6. Process Status 

As we work on our design, we may make changes that require some or all of the processes

be rerun. For example, if we edit a source file, it may require that the Synthesis process and

subsequent process be rerun. Project Navigator keeps track of the changes we make and

hows the status of each process with tll'e following status icons:

Running

This icon shows that the process is running.

•

• Up-to-date

This icon shows that the process ran successfully with no errors or warnings and does not

d to be rerun. If the icon is next to a report process, the report is up-to-date; however,

ociated tasks may have warnings or errors. If this occurs, we can read the report to

termine the cause of the warnings or errors.
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Warnings reported

This icon shows that the process ran successfully but that warnings were encountered.

Errors reported O
This icon shows that the process ran but encountered an error.

• Out-of-Date

This icon shows that we made design changes, which require that the process be rerun. If

· s icon is next to a report process, we can rerun the associated task process to create an up­

date version of the report.

No icon

If there is no icon, this shows that the process was never run .

. 7. Running Processes 

To run a process, we can do any of the following:

Double-click the process, right-click while positioned over the process, and select Run

m the popup menu, as shown in the following figure.

Figure 1.3 Pop-Up Menu for Run

Select the process, and then click the Run toolbar button~-

• To run the Implement Design process and all preceding processes on the top module

for the design, select Process > Implement Top Module, or click the Implement

Top Module toolbar button@l:.

hen we run a process, Project Navigator automatically processes our design as follows:

Automatically runs lower-level processes.
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When we run a high-level process, Project Navigator runs associated lower-level

rocesses or sub-processes. For example, if we run Implement Design for our FPGA design,

all of the following sub-processes run: Translate Map, and Place & Route.

• Automatically runs preceding processes

When we run a process, Project Navigator runs any preceding processes that are required,

ereby "pulling" our design through the design flow. For example, to pull our design through

e entire flow, double-click Generate Programming File.

Automatically runs related processes for out-of-date processes.

If we run an out-of-date process, Project Navigator runs that process and any related

ocesses required to bring that process up to date. It does not necessarily run all preceding

esses. For example if we change our UCF file, the Synthesize process remains up to date,

t the Translate process becomes out of date. If we run the Map process, Project Navigator

s Translate but does not run Synthesize. For more information on running processes,

luding additional Process menu commands .

. 8. Setting Process Properties 

Most processes have a set of properties associated with them. Properties control

cific options, which correspond to command line options. When properties are available

a process, we can right-click while positioned over the process and select Properties from

popup menu, as shown in the following figure.

Figure 1.4 Pop-Up Menu for Properties ••

When we select Properties, a Process Properties dialog box appears, with standard

rties that we can set. The Process Properties dialog box differs depending on the process

After we become familiar with the standard properties, we can set additional,

anced properties in the Process Properties dialog box; however, setting these options is not 
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recommended if we are just getting started with using the iSE software. When we enable the

dvanced properties, both standard and advanced properties appear in the Process Properties

dialog box.

2.2.9. Using the Workspace 

When we open a project source file, we open the Language Templates, or run certain

rncesses, such as viewing reports or logs, the corresponding file or view appears in the

'orkspace. We can open multiple files or views at one time. Tabs at the bottom of the

·orkspace show the names for each file or view. A tab is clicked to bring it to the front.

To open a file or view in a standalone window outside of the Project Navigator

orkspace, the Float tool bar button is used. To dock a floating window, the Dock toolbar

utton is used.

Float r::ı,

Dock tc'1

The Dock toolbar button is only available from the floating window .

.•.. 2.10. Using the Transcript Window 

The Console tab of the Transcript window shows output messages from the processes we

n. If a line number appears as part of the message, we can right-click the message and select

Goto Source to open the source file with the appropriate line number highlighted.

Warning A ..
•

• Error

Depending on the source file and tool we are working with, additional tabs are available in

the Transcript window:

• Always available: Console tab, Errors tab, Warnings tab, Tel Console tab, Find in

Files tab.
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• ISE Simulator: Simulation Console tab.

RTL and Technology Viewers: View by Name tab, View by Category tab .

. 11. Using the Toolbars

Toolbars provide convenient access to frequently used commands. To execute a

mmand a toolbar button click once on. To see a short popup description of a toolbar button,

mouse pointer is holding over the button for about two seconds. A longer description

pears in the status bar at the bottom of the main window.

For Help on a toolbar button, the Help toolbar button I\? is clicked, and then the

lbar button is clicked for which we want Help. For more information on getting Help, we

uld see Using Xilinx Help.

2.3. Working with Projects

.1. Creating a Project

Project Navigator allows us to manage our FPGA and CPLD designs using an ISE™

ıject, which contains all the files related to our design. First, we must create a project and

n add source files. With our project open in Project Navigator, we can view and run

esses on all the files in our design. Project Navigator provides a wizard to help us create a 

w project, as follows.

Create a Project

Select File > New Project.

In the New Project Wizard Create New Project page, steps are as follows:
•

• In the Project Name field, we enter a name for the project. It follows the

naming conventions described in File Naming Conventions.
• •

• In the Project Location field, we enter the directory name or browse to the 

directory.

• In the Top-Level Source Type drop-down list, we select one of the following:

HDL

We select this option if our top-level design file is a VHDL, Verilog, or ABEL (for

) file. An HDL Project can include lower-level modules of different file types, such as

HDL files, schematics, and "black boxes," such as IP cores and EDIF files.
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Schematic

We select this option if our top-level design file is a schematic file. A schematic

iect can include lower-level modules of different file types, such as HDL files, other

matics, and "black boxes," such as IP cores and EDIF files. Project Navigator

rnatically converts any schematic files in our design to structural HDL before

lementation; therefore, we must specify a synthesis tool when working with schematic

iects, as described in step 5.

EDIF

Select this option if you converted your design to this file type, for example, using a

thesis tool. Using this file type allows you to skip the Project Navigator synthesis process

to start with the implementation processes.

NGC!NGO 

This option is selected if the design is converted to this file type, for example, using a

thesis tool. Using this file type allows us to skip the Project Navigator synthesis process

tart with the implementation processes.

3. Click Next.

4. If we are creating an HDL or schematic project, we skip to the next step. If we are

creating an EDIF or NGC/NGO project, we should do the following in the Import

EDIF/NGC Project page:

In the Input Design field, we enter the name of the input design file, or browse to the

file and it is selected. ..
•

Select Copy the input design to the project directory to copy our file to the project

directory. If we do not select this option, our file is accessed from the remote

location.

In the Constraint File field, we should enter the name of the constraints file, or browse

to the file and select it.
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Select Copy the constraints file to the project directory to copy our file to the project

directory. If we do not select this option, our file is accessed from the rem te ~·:)-
'< location. ~t 

- In the Device Properties page, we should set the following options. These settings

affect other project options, such as the types of processes that are available for our

design.

Product Category

Family

To target a Spartan-3L™ device, Spartan-3™ should be selected as the family. When

ing an EDIF project, the device family information is read from our EDIF project file,

hanging the device family is not recommended.

Device

To target a Spartan-3L device, device that ends in 1 should be selected, such as

Package

Speed ..
•

Top-Level Source Type

This is automatically set.

Synthesis Tool

52



We select one of the following synthesis tools and the HDL language for our project.

VHDL/Verilog is a mixed language flow. If we plan to run behavioral simulation, our

imulator must support multiple language simulation.

XST (Xilinx® Synthesis Technology)

XST is available with ISE Foundation™ software installations. It supports projects

at include schematic design files and projects that include mixed language source files, such

~ VHDL and Verilog sources files in the same project. For more information, see.

Synplify and Synplify Pro (Synplicity®, Inc.)

The Synplify® software does not support projects that include mixed language source

es. The Synplify Pro® software supports projects that include mixed language source files,

such as VHDL and Verilog sources' files in the same project. The Synplify and Synplify Pro

software do not support projects that include schematic design files.

LeonardoSpectrum (Mentor Graphics®, Inc.)

The LeonardoSpectrum™ software supports projects that include schematic design

es. It does not support projects that include mixed language source files, such as VHDL and

'erilog sources files in the same project.

Precision (Mentor Graphics®, Inc.)

The Precision® software supports projects that include schematic design files and

rojects that include mixed language source files, such as VHDL and Verilog sources files in

e same project.

Simulator

We select one of the following simulators and the tJDL language for simulation. The

anguage we select determines the default language in which to generate simulation netlists

d other generated files that affect simulation. We can also select the language in which to

generate files by setting process properties as described in Setting Process Properties.

ISE Simulator (Xilinx®, Inc.)

This simulator allows us to run integrated simulation processes as part of our ISE

ign flow.
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ModelSim (Mentor Graphics®, Inc.)

We can run integrated simulation processes as part of our ISE design flow using any

f the following ModelSim® editions: ModelSim Xilinx Edition (MXE), ModelSim MXE

tarter, ModelSim PE, or ModelSim SE™.

NC-Sim (Cadence®, Inc.)

The NC-Sim simulator is not integrated with ISE and must be run standalone.

VCS (Synopsys®, Inc.)

The VCS® simulator is not integrated with ISE and must be run standalone.

Others

We select this option if we do not have ISE Simulator or ModelSim installed or if we

ant to run simulation outside of Project Navigator. This instructs Project Navigator to

- able the integrated simulation processes for our project.

Enable Enhanced Design Summary

We select this option to show the number of errors and warnings for each of the

tailed Reports in the Design Summary.

Enable Message Filtering

We select this option to show the number of messages we filtered in the Design

.-uu.uıary. We must enable this option, filter messages, and then run the software to show the

ber of filtered messages.

Display Incremental Messages

We select this option to show the number of new messages for the most recent software

in the Design Summary. We must enable this option and then run the software to show the
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e are creating an EDIF or NGC/NGO project, we should skip to step 8. If we are

ııır.aıing an HDL or schematic project, we click Next, and optionally, we create a new

e file for our project in the Create New Source page. We can only create one new

e file while creating a new project. We can create additional new sources after

- Next, and optionally, add existing source files to our project in the Add Existing

Next to display the Project Summary page.

· Finish to create the project.

fer, we can create a project using the New Project dialog box instead of the New

ızard, as described above. To use the New Project dialog box, we should deselect

· project wizard option in the iSE General Options page of the Preferences dialog

· t Navigator creates the project file, project_name.ise, in the directory we

All source files related to the project appear in the Project Navigator Sources tab.

rigator manages our project based on the project properties (top-level module type,

ynthesis tool, and language) we selected when we created the project. It

the parts of our design and keeps track of the processes necessary to move the

design entry through implementation to programming the targeted Xilinx device.

tion on changing project properties, we see Changing Project, Sources and
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We can perform any of the following:

To create and add source files to our project.

To add existing source files to our project.

To run processes on our source files .

.2. Working with Snapshots

A snapshot is a read-only copy of the current project that allows us to do the following:

• To save different versions of our project for comparison

• Revert to a previously saved version of our project

..\ snapshot includes all of the files and directories in the project directory, such as source

. implementation files, and process files. Archiving is similar to using snapshots.

ever, archives are stored in ZIP files and cannot be opened within Project Navigator,

ut first being unzipped outside of Project Navigator.

to Do First

We open a project in Project Navigator.

"'Select Project > Take Snapshot.

In the Take a Snapshot of the Project dialog box, we enter a name for our snapshot in
•the Snapshot Name field.

In the Comment field, we add any notes related to this version of our project.

Comments are optional.

Click OK.

our project includes source files that resides outside of the project directory, these

e source files are copied to a remote sources directory in the snapshot.
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To View a Snapshot

• In the Sources window, we click the Snapshots tab.

• In the Snapshots tab, we select the desired snapshot.

• Select Source > Open to view the hierarchy of our design, or click the plus (+) or

minus (-) icons to collapse and expand the levels. We can double-click a source file to

open it for viewing in the Project Navigator Workspace.

To Rename a Snapshot or to Add Comments

• In the Snapshots tab, we select the top-level directory of the snapshot.

• Select Source > Properties.

• In the Snapshot Properties dialog box, we change the snapshot name or add comments.

• Click OK.

To Remove a Snapshot

Caution! Snapshots are deleted from the disk when removed from a project.

,!

• In the Snapshots tab, we select the top-level directory of the snapshot to delete.

• Select Source > we remove, or press the Delete key on the keyboard.

• Click Yes to delete the snapshot directory from our disk.

o Replace the Project with a Snapshot

This procedure replaces the project with a saved snapshot version. Our project is
•erwritten unless we take a snapshot of it before we replace'it,

following procedure describes how to revert to a previously saved version of our project:

• In the Snapshots tab, we select the top-level directory of the snapshot.

• Select Project> Make Snapshot Current. 

Because this procedure overwrites our current project, we are prompted to save our

urrent project as a snapshot. Click Yes to save the current project as a snapshot, or

. ,o to overwrite the current project without saving it as a snapshot.

57



The current project in the Sources tab is replaced by the selected snapshot. In addition, the

original snapshot also remains intact in the snapshots directory. If our snapshot included

remote sources in a remote sources directory, the remote sources directory is automatically

opied to the project directory. However, the restored project maintains the links to the remote

location of the source files, not to the files in the remote sources directory. If we want to work

with the snapshot version of the remote source files, we must manually copy them from the

mote sources directory to the remote location.

Each snapshot is stored in a separate directory named with the Snapshot Name we

cified. These directories are located in the snapshots directory under the top-level directory

"or the associated project. In the Project Navigator, each snapshot is shown in the Snapshots

2.4. Working with Projects Source File

_.4.1. Creating a Source File
A source file is any file that contains information about a design. Project Navigator

rovides a wizard to help us create new source files for our project. If we are targeting a

Spartan-3A or Virtex-5 device, we can use the New Source Wizard to pre-assign package pins

tor an empty project. For details, Pre-Assigning Package Pins in the New Source Wizard.

What to Do First

Open a project in Project Navigator.

To Create a Source File ••

••

• Select Project> New Source.

• In the New Source Wizard, we select the type of source we want to create. Different

source types are available depending on our project properties (top-level module type,

device type, synthesis tool, and language). Some source types launch additional tools

to help us create the file, as described in Source File Types.

• We enter a name for the new source file in the File Name field. Then we follow the

naming conventions described in File Naming Conventions.
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• In the Location field, we enter the directory name or browse to the directory.

• We select Add to Project to automatically add this source to the project. State

machines created with StateCAD cannot be automatically added to the project. We

must add them manually.

• Click Next.

• If we are creating a source file that needs to be associated with an existing source file,

we should select the appropriate source file, and click Next. If this does not apply, skip

to the next step.

• In the New Source Information window, we can read the summary information for the

new source, and we click Finish.

After we click Finish, the New Source wizard closes. In some cases, a related tool is

unched in which we can finish creating our file. After the source file is created, it appears in

e Project Navigator Sources tab. If we selected Add to Project when creating the source file,

e file is automatically added to the project.

-4.2. Source File Types

The following table shows the source file types that appear in the Project Navigator

ources tab. Available source types vary depending on our project properties (top-level

module type, device type, synthesis tool, and language). The last column describes what to

expect when creating the file with the New Source wizard and, if applicable, inclu~es the tool

aunched when using the New Source wizard or when editing the file from Project Navigator.

Table 1.3 Source File Types
~

File Type Extension Icon Description New Source Wizard..
Behavior/Tool Launched

••_.\BEL Test .abv ~ Describes input Associates the file with the top-

Vector stimulus and level module and opens the

expected outputs for empty vector file in the text

logic simulation of editor we specify in the Editor

ABEL design code. Options page of the

Preferences dialog box.

..\BEL-HDL .abl ~ Contains ABEL Allows you to specify your pin
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design code. names and opens the file in the

text editor we specify in the

Editor Options page of the

Preferences dialog box.

.bmm ~ Used in Power PC™ Opens the file in the text editor

and MicroBlaze™ we specify in the Editor

processor designs to Options page of the

describe the Preferences dialog box. The

organization of CPU executable code is

Block RAM automatically inserted in the

memory. configuration file during design

Note Only one implementation.

BMM Module is

allowed per project.

ope .ede ~ Contains generic Adds the file to the project.

information about Double-click the CDC file in

the trigger ancıclata the Sources tao to run the

ports of the implementation process and

ChipScope™ core. launch the ChipScope Pro TM

Core Inserter. For details, see

the ChipScope Pro Debugging

Overview.

ChipScope Pro must be

installed for this source type to

"
be available.

ectronic Data .edn, .edf, [5J Specifies the design NIA 

erchange .edif, netlist in an industry Must be generated by a third-•
Format (ED IF) .sedif standard file format. party design entry tool and

added to the project.

We can only add an ED IF file

as a top-level module, not as a

lower-level module. If you are

using hierarchical EDIF files,

lower-level EDIF files are
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the implementation process.

.elf \SJ Contains an NIA 

executable CPU Must be generated by the

code image. Data2MEM command line tool

Only one ELF file is and added to the project.

allowed per project.

Embedded .xmp ~ Contains predefined Launches the Xilinx Platform

Processor logic functions. Studio in which we can define

the embedded processor system

portion of our design. For

details, see the Embedded

Development Kit

Documentation.

J/0 Pin .ucf and .v Allows us to create The 1/0 pin assignment data

Assignments or .vhd and add a UCF file displays in the Floorplan View

with 1/0 pin data and Package View in the

and add a template Workspace. Pin assignments

HDL file to an are saved in the UCF, which is

empty project. added to the project and

associated with the template

HDL file. The output HDL file

displays in the iSE Text Editor

in the Works pace. This feature

is only supported for

• Spartan™-3A and Virtex™-5

devices. For details, Pre-•
Assigning Package Pins in the

New Source Wizard.

Implementation .ucf ~ Contains user- Adds the file to the project.

Constraints File specified logical Double-click the UCF file in

o known as constraints. the Sources tab, or double-click

Cser Constraints a Constraints Entry process in

File (UCF) the Processes tab to open the
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file. For details, see Constraints

Entry Methods.

Architecture .xaw Contains predefined Launches one of the Xilinx

logic functions that Architecture Wizards in which

configure we can define our IP. For

architecture features details, see Working with

or modules. Architecture Wizard IP.

(CoreGen) .xco 'Q. Contains predefined Launches the Xilinx CORE

logic functions. Generator™ software in which

we can define your IP. For

details, see Working with

CORE Generator IP.

.mem rg Used to define the Opens the file in the text editor

contents of memory we specify in the Editor

(RAMB4 and Options page of the

RAMB16). Preferences dialog box. The

Only one MEM file CPU executable code is

is allowed per automatically inserted in the

project. configuration file during design
I
'·I'.

implementation.

Project .ıse '3 Contains process NIA 

property settings,

status, and

information for

managing the ISE™

project. ••
Schematic .sch ~ Contains a Opens the schematic file in the•

schematic design. Project Navigator Workspace.

For details, see the Schematic

Overview.

State diagram .dia Contains a state Launches StateCAD in which

diagram file. we can define your state

diagram. For details, see

Working with State Machines.

62



NIA a Shows the targeted NIA 

device,package,and

speed grade.

.tbw BJ Contains a graphical Prompts you to associate the

representation of a file with a source and opens the

test bench that can Test Bench Waveform Editor

be converted to an in the Project Navigator

HDL test bench or Workspace with the signals

test fixture. populated. For details, see the

iSE Simulator Help. This file is

for use with the Xilinx® Test

Bench Waveform Editor only.

NIA ~ Contains an NIA 

instantiated module

that has not been

added to the iSE

project but is

referenced by a

source file in the

iSE project.

.doc, .txt, ~ Contains user NIA 

.wrı information that is Must be added to the project.

not implemented

with the project, for

example, supporting

documentation.

.v ~ Contains Verilog Opens the file in the text editor

design code. we specify in the Editor

Options page of the

Preferences dialog box.

.v ~ Defines the stimulus Prompts you to associate the

to the ports of an file with a Verilog source

HDL file. module and then opens a

skeleton test bench file in the
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text editor you specify in the

Editor Options page of the

Preferences dialog box.

VHDL Library .vhd Uô Contains a Adds a new directory to the

collection of VHDL vhdl library directory in the

packages. Libraries tab.

VHDLModule .vhd ~ Contains VHDL Opens the file in the text editora 

design code. we specify in the Editor

Options page of the

Preferences dialog box.

VHDL Package .vhd ~ Contains definitions, Opens the file in the text editor

macros, sub- we specify in the Editor

routines, Options page of the

supplemental types, Preferences dialog box.

subtypes, constants,

functions, and other

files.

VHDL Test .vhd ~ Defines the stimulus Prompts we to associate the file
Bench to the ports of an with a VHDL source and then .... ,

Iı:,
HDL file. opens a skeleton test bench file

in the text editor we specify in

the Editor Options page of the

Preferences dialog box.

2.4.3. Adding a Source File to a Project

Project Navigator allows us to add an existing source file to a project. The source file
•carı reside jn the project directory or in a remote directory. If we generated our source file

ing the New Source wizard and selected Add to Project, we do not need to add the source

ıle to our project; it is automatically part of our project. The only exception is state diagrams,

'hich must be added manually.

If we want to copy a source file from a remote directory to our project directory and

dd it to our project, use the Add Copy of Source command instead, as described in Adding a

Copy of a Source File to a Project. If we are working with CORE Generator™ or Architecture

izard IP, we must use the Add Copy of Source command to copy the IP core and associated
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-·es that reside in a remote directory to our local project directory. The files will not simulate

implement correctly if we add them as remote source files.

What to Do First 

Open a project in Project Na"1igatrn:.

o Add a Source File to a Project

• Select Project > Add Source.

Alternatively, we can double-click Add Existing Source in the Processes tab.

• In the Add Existing Sources dialog box, we browse to the source file and we select

it.

• Click Open.
• In the Adding Source Files dialog box, we select the Design View in which we

want the source file to appear.

If we want to change the Design View association after the source file has been added,

select the source file in the Sources tab, and then select Source > Properties.

• Click OK.
I

What to Expect
The source file is added to your proj~ct, and the file appears as part of the design

hierarchy in the Sources tab. If you added a remote source, the directory path appears with the

file name. •
If the source file you added refers to files that have not been added to the project, the

file names appear in the design hierarchy as undefined files You must add the referenced

files to the project for the ISE software to track changes to the files.

We cannot add fixed netlist IP to an ISE project. However, you must include the IP

cores in your project directory to use them in your project.
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4.4. Adding a Copy of a Source File to a Project

Project Navigator allows us to copy a source file from a remote directory to our

ıjectdirectory and then, add it to our project as follows. If we want to leave the source file

the remote directory and add it to our project, see Adding a Source File to a Project.

,lıat to Do First
Open a project in Project Navigator.

To Add a Copy of a Source File to a Project

Select Project > Add Copy of Source.
In the Add Existing Sources dialog box, browse to the source file and select it.

Click Open.
In the Adding Source Files dialog box, select the Design View in which we want the

source file to appear.
If we want to change the Design View association after the source file has been added,

select the source file in the Sources tab, and then select Source > Properties.

Click OK.

What to Expect
The copy of the source file is placed in the project directory and is added to our

project. The file appears as part of the design hierarchy in the Sources tab.

If the source file we added refers to files that have not been added to the project, the file

names appear in the design hierarchy as undefined files. We must add the referenced files to

the project for the ISE software to track changes to the files.

Note: Some support files, such as CORE Generator wrapper and symbol files, are

automatically copied to the project directory when we copy the source file. •
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4.5. Editing a Source File

After we create a source file, we can edit it using the iSE™ software.

,nat to Do First

Open a project in Project Navigator.

o Edit a Source File

In the Sources tab, select a Design View from the drop-down list. Double-click the

urce file. Edit the file in the tool that appears. Each source type launches a different tool to

lp us to edit the file, as described in Source File Types. See the Help provided with each

ool for detailed information.

tep3- What to Expect

After we edit the source file, you may need to rerun certain processes to bring the

reject up-to-date, as described in Running and Stopping Processes.

4.6. Removing Files from a Project

We can remove files from a project that we no longer need. The file is removed from

e project, but is not deleted from our disk.

Caution! When we remove snapshots, the snapshot directory is deleted from the disk. For

tails, see Working with Snapshots.

'hat to Do First

Open a project in Project Navigator.

To Remove a Source File from a Project.

the Sources tab, select a Design View from the drop-down list.

..
•

elect the file to remove.

elect Source > Remove, or press the Delete key on the keyboard.

Click yes to remove the file from our project.
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What to Expect
The file is removed from our project. Removing a source file may alter the status for

ertain processes in the Processes tab. We may need to rerun certain processes to bring the

project up-to-date, as described in Running and Stopping Processes.

2.4.7. Working with VHDL Libraries
VHDL library files allow us to store commonly used packages and entities that we can

use in our VHDL files. A VHDL package file contains common design elements that we can

use in the VHDL file source files that make up our design. We use the following procedures

to create VHDL libraries and package files and to move package files from one library to

another.

What to Do First
Open a project in Project Navigator.

To Reference a VHDL Library or Package File.
To reference a VHDL library or package file in our VHDL file, we do the following:

• To reference a package file, include a use statement.

• To reference a library file, include a use and a library statement. When referencing

a library, you must declare both the library and package name.

To Create a VHDL Library
The ISE software provides a work library. However, we can create our own libraries

as described in Creating a Source File. We select VHDL Library as our source type.

After we create the VHDL library, tlıe new library appears in the vhdl library. Click

the Libraries tab to view the vhdl library.
••

~ote: The Libraries tab also contains a verilog library in which you can store Verilog files for

our reference. However, if we want to store commonly used modules and components that we

an use in our Verilog files, see Working with Verilog Header Files.

To Create a VHDL Package File
We can create a VHDL package file as described in Creating a Source File. Select

VHDL Package as our source type.
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After we create the VHDL package file, the new file appears at the top of the Sources tab. By

default, the new VHDL package file is added to the work library. Click the Libraries tab to

view the work library. To move the file to a different library, see the following procedure:

To Move a VHDL Package File to a Library

To move a VHDL package file from one library to another, for example, from the

default work library to a library that we created, the following should be done:

In the Sources window, click the Libraries tab.

Select the VHDL package file to move.

Note: We can only move package files with the .vhd extension. We cannot move any .vhd

file. By default, new VHDL package files display at the bottom of the work library hierarchy.

Select Source> Move to Library.

In the Choose Library dialog box, select the library to move the file to.

Click OK.

2.5. Working with Processes

2.5.1. Running and Stopping Processes

In the Processes tab, we can run processes on our selected source file. We can run a

task, generate a report, or launch a tool. We can also stop a process while it is running.

What to Do First

Open a project in Project Navigator.

To Run a Process

In the Sources tab, select a Design View from the drop-down list.

Select the source file to process. •
The source file we select affects the processes that appear in the Processes tab; only

the processes that apply to the selected source are shown.

In the Processes tab, we select a process.

From the Process menu, we select one of the following commands:

Run to run the selected process and any preceding processes that are out of date.

.Alternatively,we can double-click the process to run it.

Rerun to force a run on the selected up-to-date process.
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Rerun all to force a run on the selected up-to-date process and all processes that precede the

selected process.
Open without Updating to open a file for an out-of-date task or to open an out-of-date

report for investigative purposes.
We can also right-click a process and select one of these commands.

To Stop a Process
To stop the currently running process, select Process> Stop.

Stopping a process is not always immediate; some processes may proceed until a suitable

topping point is reached.

What to Expect
One of the following status icons appears next to the process in the Processes tab:

Running
This icon shows that the process is running.

Up-to-date
This icon shows that the process ran successfully with no errors or warnings and does not

need to be rerun.
:-;ı;

Warnings reported ~
This icon shows that the process ran successfully but that warnings were encountered.

Errors reported
This icon shows that the process ran but encountered an error.

"'

Out-of-Date
This icon shows that you made design changes, which require that the process be rerun. If this• •.icon is next to a report process, we can rerun the process to create an up-to-date version of the

report.

~o icon
If there is no icon, this shows that the process was never run.
If a process is marked as up-to-date, warnings reported, or errors reported, we cannot use the

Run command.
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2.5.2. Setting Process Properties

We can set process properties that enable us to control the way our design is

implemented. Properties differ based on the device family we are targeting, our top-level

module type, and our synthesis tool. In addition, there are both standard and advanced

properties. By default, only the standard properties display in the Process Properties dialog

box.
Setting advanced options is not recommended if we are just getting started with using

the ISE™ software. When we enable the advanced properties, both standard and advanced

properties appear in the Process Properties dialog box.

What to Do First
Open a project in Project Navigator. To Set Process Properties

In the Sources tab, select a Design View from the drop-down list.

Select the source file to process.
The source file we select affects the processes that appear in the Processes tab; only

the processes that apply to the selected source are shown.

In the Processes tab, select the process for which we want to set properties.

Select Process > Properties.
We can also right-click the process and select Properties. If there are no properties for

a process, the Properties menu item is grayed out.

In the Process Properties dialog box, change the property options.
For detailed information on each of the options, click the Help button in the dialog

box.

Select OK.

What to ?xpect •
The new property settings are used the next time we run the selected process.

Some properties are dependent on other properties. The values of dependent properties may

change based on other property values that you set.
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.!.5.3. Setting Command Line Options using Process Properties

In some cases, the Process Properties dialog box may not include an option for the

commandline option we want to set. In this case, we can enter the command line option using

vanced properties in the Process Properties dialog box.
__ote For details on most command line options, see the Development System Reference 

Guide. For details on XST command line options, see the XST User Guide. For details on

CompXlib command line options, see the Synthesis and Simulation Design Guide. For details

n ModelSim® command line options, see the documentation provided with the ModelSim

ftware.

oat to Do First
Set your Process Settings preference to Advanced.

To Set Command Line Options; in the Sources tab, select a Design View from the drop-down

· st. Select the source file to process.

__ote: The source file we select affects the processes that appear in the Processes tab. For

example, we must select the top module for the Implement Design process to appear.

the Processes tab, select the process for which we want to enter command line options.

elect Process > Properties.

_,ote: We can also right-click the process and select Properties. If there are no properties

lor a process, the Properties menu item is grayed out.
In the Process Properties dialog box, enter command line options in the Other Application

ame Command Line Options field. Separate multiple options with a space.

_ _-ote: To view the command line used for a process, see the command line log file as

escribed in viewing a Command Line Log File. Partner proce~ses, such as syntheşis

-ommands for the Synplify® tools, are not recorded in the command line log file.

Click OK.

i\'hat to Expect
The new property settings are used the next time we run the selected process. The

iollowingtable shows how certain Project Navigator processes correspond to command Line

ools.

72



Table 1.5 Project Navigator Corresponds to Line Tools

Process Process Properties Tab Command Line

Tool

Compile HDL Simulation Libraries Simulation Library Compiler CompXLib

Properties

Synthesize - XST Synthesis Options XST

Translate Translate Properties (FPGA) NGDBuild

Design Properties (CPLD)

Generate Post-Translate Simulation Simulation Model Properties NetGen

Model

Map Map Properties MAP

Generate Post-Map Simulation Model Simulation Model Properties NetGen

Place and Route Place & Route Properties PAR

Generate Post-Place and Route Simulation Model Properties NetGen

Simulation Model

Fit (CPLD) Fitting Properties CPLDFit

Reports Properties TAEngine
•ı,ı

Generate Programming File General Options (FPGA) BitGen

Programming Properties Hprep6

(CPLD)

Generate Timing (CPLD) Timing Report Properties TAEngine

Analyze Power XPower Properties Xpower

Generate Post-Fit Simulation Model Simulation Model Properties NetGen

(CPLD)
•
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2.6. Working with Reported Data

• Reports ~

2.6.1. Reviewing Reports
When we run a task process, such as Synthesize or Map, a report is generated, such as

e Synthesis Report or Map Report. Tasks and reports are denoted by the following icons in

the Project Navigator Processes tab:

What to Do First
We run a task process in Project Navigator.

To Review a Report
We can review reports using any of the following methods:

'"!

• In the Project Navigator Processes tab; we select the report and do one of the

following:

o We double-click a report to open it.
o We select Process> Open Without Updating to open an out-of-date report for

investigative purposes, "

• In the Project Navigator Workspace, we click the Design Summary tab. We-click a

report in the upper left pane of the Design Summary to display it in the right pane. We

click the links in the lower left pane to navigate to the different sections in the report.

Only reports that include summary information are available.

• From the command line, we browse to the directory in which our output files reside

and open the report. We can open most reports using a text editor or using the xreport

command line tool, as described in Using the Design Summary for FPGAs.
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What to Expect

Project Navigator opens the report in the Workspace and indicates the status of the

report with one of the following icons in the Processes tab:

• Up-to-date

This icon shows that the report matches the associated task process and does not need

to be rerun.

• Out-of-Date

This icon shows that we made design changes, which require that the associated task

process be rerun.

IN. I• o ıcor

If there~ no icon, the report was never created.

2.6.2. Using the Design Summary for FPGAs
The Design Summary allows us to quickly access design overview information,

messages, and reports. The Design Summary is supported for FPGA designs only.

What to Do First
.ıı

We can open the Design Summary using either of the following methods:

• Project Navigator: By default, the Design Summary appears in the Workspace when
•we.open a project. If we close the Design Summary, we can reopen it by double-

clicking View Design Summary in the Processes tab. If we do not want the Design

Summary to appear in the Workspace when we open a project, deselect Open Design

Summary when project is opened in the ISE General Options page of the Preferences

dialog box.

• Command line: Type xreport. If we do not have an ISE file, we select File> New

Project to create one. When we run command line tools, we must use the -ise option

and specify the ISE project file we created.
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Viewing Design Overview Information;

The Design Overview section in the upper left pane of the Design Summary allows us

to view the following information about our design.

To View Summary Information;

We click the Summary link to view the following information in the right pane:

• Project status information, including our project name, targeted device, iSE version,

the state of our design, the number of errors and warnings, and the date and time the

summary was generated.

• Device utilization summary, which shows the estimated utilization after XST synthesis

and the actual utilization after mapping.

• Performance data that summarizes place and route results.

• Links to detailed reports with high-level information about each report.

• Links to secondary reports, such as the Xplorer Report.

Working with Messages;

The Errors and Warnings section in the upper left pane of the Design Summary allows

us to view and manipulate messages. We click the links under the Errors and Warnings

section to show messages in the right pane. We must select the Enable Enhanced Design

Summary option in the lower left pane to view and manipulate messages. We can manipulate

the messages as follows. ii
,.:1

To Organize Messages;
Select or deselect the following options in the lower left pane of the Design Summary

to organize the messages in the right pane: •

• Organize Messages options

o Flat shows all messages in chronological order.

o Collate Consecutive collapses messages with the same message number that

appears next to one another in chronological order.

o Collate All collapses all identical messages.
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• View Messages options show or hide errors, warnings, or information messages.

• Show Columns options show or hide table columns.

To Filter Messages;
Many of the processes we run using the iSE™ software generate messages. In some

cases, we may want to suppress a particular message from appearing. For example, we may

get a warning message about an unconnected pin that we intend to be unconnected.

To suppress the message from subsequent runs of the iSE software, we do the

following:

• In the upper left pane, we click Summary.

• In the lower left pane, we make sure Enable Message Filtering is selected.

• In the upper left pane, we click a link under the Errors and Warnings section.

• In the right pane, we right-click the message to filter and select one of the following

commands:

o Filter All Instances of This Message to filter out messages with the same

library name and message number, regardless of the message text.

o Filter This Instance Only to filter out messages with the same library name,

message number, and text.

ıı,ı

To remove a filter we created or to use more advanced message filtering, we can use

the Message Filters tool, as described in Using Message Filters. When we suppress a message,

it does not mean the issue is fixed. We do not filter messages for issues that must be fixed.
" 

'!
,.,,,j

To Highlight Messages;
We right-click a message and select one of the following commands:

•

• Highlight All Instances highlights messages with the same library name and message

number, regardless of the message text.

• Highlight This Instance highlights messages with the same library name, message

number, and text.
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• · We remove Highlighting restores the message to its original color.

Tag Messages;
In some cases, we may want to tag messages with our own categories, for example

rity." To create our own categories and tag messages, we do the following:

To create a tag as follows:
o We right-click in the right pane, and we select Create Tags.

o In the Create Tags dialog box, we click Add Tag Category.

o In the Add Tag Category dialog box, we type a name for the category (for

example, "Severity"), and we click OK.
o In the Create Tags dialog box, we click our new category and we select Add

Tag Value.
o In the Add Tag Value dialog box, we type a name for the value (for example,

"High"). We create as many tag values as we need, and we click OK.

o In the Create Tags dialog box, we click OK.

• Right-click a message and select one of the following commands:
o Tag All Instances of This Message tags messages with the same library name

and message number, regardless of the message text.

o Tag This Instance Only tags messages with the same library name, message

number, and text.

,,

• In the Tag Message dialog box, select the tag to apply.
i!

... :ı

• Click OK. .•
•.

To Show New Messages;
To show the number of new messages for the most recent software run, we do the

following:

• In the upper left pane, we click Summary.

• In the lower left pane, we make sure the Enable Enhanced Design Summary and

Display Incremental Messages options are selected.
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• We run the software.

• Do either of the following in the upper left pane:

o We click Summary to view summary information in the right pane, which

includes the number of new messages.

o We click the links under the Errors and Warnings section to show messages in

the right pane, with new messages marked as New.

2.6.3. Using Message Filters
Many of the processes we run using the iSE™ software generate messages. In some

cases, we may want to suppress a particular message from appearing. For example, we may

get a warning message about an unconnected pin that we intend to be unconnected. To

suppress the message from subsequent runs of the iSE software, we can use Message Filters.

Filtered messages are suppressed from reports, from the Project Navigator Console tab, and

from command line output, but are shown in the Message Filters tool.

We can filter most messages that begin with "WARNING" or "INFO" and are

followed by a library name and message number. For example, the following message can be

filtered:

WARNING:Xst:454:message text 

Where Xs t is the library name and 4 5 4 is the message number. In this case, the

library name is the internal Xilinx® library that stores the message. Messages for some

processes cannot be filtered, for example, messages generated by third-party software, such as

the Synplicity® software.

ii
.:ı

When we suppress a message, it does not mean the issue is fixed. We should not filter

messages for issues that must be fixed. •

Message Filtering Basic Steps;
Message filtering comprises the following basic steps. For detailed procedural

information, we see Filtering Messages from Project Navigator or Filtering Messages from

the Command Line, depending on how we are running the iSE software.
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• We launch the Message Filters tool.

• In the Message Filters tool, we enable message filtering and we save our settings.

• We run the ISE software.

• In the Message Filters tool, all the messages generated by the ISE software that can be

filtered appear in the Messages List.

• In the Filters List, create filters for the messages that we want to filter out of

subsequent runs of the ISE software.

• We save the message filters we created.

• We run the ISE software. The messages for which we created filters no longer appear.

Message Filters Main Window;

The Message Filters tool allows you to create filters for most warning and

informational messages. This tool contains the following parts.

Files Window
This window shows the project for which we are applying filters and allows us to enable or

disable filtering. It also shows the Message Sources, which are the programs that produced

messages.

Filters List

This is the window in which we create and store our message filters.

Messages List

This window shows all the messages generated by the most recent ISE software run. We can

drag the messages from this list to the Filters List to create new filters.

Filters List and Messages List Tables
•

The tables in the Filters List and Messages List include the following parts:
••

• Filters List icons

Disabled filter X
This icon indicates that you temporarily stopped the filter using the Disable command

available from the right-click menu.
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Invalid filter 8
This icon indicates that the filter we created cannot be applied. Messages that are

missing a necessary entry, such as the Message number or Library entry cannot be filtered.

Note Invalid filters are not saved, that is, when we close and then reopen the Message Filters

tool, the invalid filters do not appear.

New filter
In the Filters List, this icon indicates that the filter has not yet been applied.

• Source

This column shows the program that generated the message.

• Type

This column shows the icons for the following message types:

Warning message

Warnings indicate problems with our design. When filtering out warning messages,

make sure that we are not filtering out a message that requires fixing the problem instead. "Ii
.:ı

Informational message
..

Informational messages are less severe than warnings and provide helpful"suggestions

for improving our design. For example, informational messages may suggest that we

improve your coding style.
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• Library

This column shows the internal Xilinx® library that stores the message. The library

name appears as part of each message. For example, in the following message, Xst is the

library name:

WARNING: Xst:454:message text 

In some cases, the Library field matches the Source field.

• Msg#
This column shows the message number used by the software program.

• Filter Text
In the Filters List, this column shows the message text to filter. If we delete the

variable text in this field, all messages with the same message number are filtered,

regardless of the message text. If we keep the variable text in this field, only messages that

have the same number and exact message text are filtered. We can also click the variable

text and enter wildcards to create filters. Variable text is blue and underlined.

• Count
In the Filters List, this column shows the number of times the filter was applied in our

most recent software run. We double-click this cell to get additional information about the

filter count.

• Message Text

In the Messages List, this column shows the text for the captured messages.

• Filtered

In the Messages List, this icon indicates that the message was filtered.

•
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CONCLUSION.

By using vhdl language i have proof that it is very possible to create & realize the way a

UART transmitter works and the way it get the data in a parallel form and transfer it out in a

form of serial data so easily.

Now at the end its very easy to put this program in a electronic programmable chip and

therefore in this way I can have the UART tansmitter physically.

The benefit that we gained by using a vhdl xilinx is just to get rid of the hardware and

bunddle of cables and resistors, connections after all if only a single cable or a connection is

missing or misplace the whole design can be easily destroyed and moreover its expensive and

requires red alert ATTENTIONS to go through such a process.

To sumup, extraordinary convinence and a brilliant results can only be achieved by using

VHDL the language of today and tommrow.

•
•
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